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1 What is DanioVision?

daniovision
DanioVision™ is a system for high throughput tracking of zebrafish 
larvae in multi-well plates. It consists of:

The DanioVision Observation Chamber (DVOC-0041)
See Figure 1. This chamber contains a transparent holder with backlight 
that fits an ANSI SBS compatible multi-well microtiter plate, infrared 
(IR) and white light sources (underneath the microtiter plate), and a 
Gigabit Ethernet (GigE Vision) video camera. The optical design 
provides a stable and undistorted top view of each well and a 
controlled and constant environment within the observation chamber.

For technical specifications and for cleaning instructions, see System 
specifications.

tip  You find your DanioVision’ version number on 
the label at the back of the chamber.

Figure 1  The DanioVision Observation Chamber DVOC-0041.
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EthoVision® XT
Video-tracking software with the Multiple Arenas Module and Trial & 
Hardware Control Module. Using Trial & Hardware Control, you can 
adjust the white light stepwise based on time or behavior of your fish. 
You have the option to connect external devices, such as sound or shock 
generators.

note  DanioVision DVOC-0041 works with EthoVision XT 10.1 or newer.

daniovision add-ons

DanioVision Temperature Control Unit
With the DanioVision Temperature Control Unit you can set up a water 
flow at constant temperature underneath the well-plate. For details, 
see the Reference Manual - DanioVision Temperature Control Unit DV-
TCU.pdf, which you can download from the Noldus website (see page 
10).

DanioVision Tapping Device
With the DanioVision Tapping Device you can trigger a startle response 
in zebrafish. For details, see The DanioVision Tapping Device in this 
manual.

DanioVision Toplight Unit
With this add-on you can generate top-down light stimuli in your 
experiments. Four types of light are available: white, red, blue and 
green. For details, see The DanioVision Toplight Unit in this manual.

DanioVision with Optogenetics
DanioVision can be provided with one to three LEDs that illuminate the 
well plates based on your Trial Control protocol. The Optogenetics add-
on allows to accurately control and time the application of optogenetic 
stimulation to up to 96 individuals simultaneously (one for each well in 
a 96-well plate). For details, see The DanioVision Optogenetics add-on 
on page 88.
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Custom solutions
As research evolves, so do research needs. If you are interested in a 
custom solution, don’t hesitate to contact us!

A few recent examples of custom solutions:

 Light-Dark Grid. Commonly used to investigate anxiety behavior in 
zebrafish. The grid is placed underneath the well plate (available for 
6, 12, 24, 48 or 96 wells) and creates a dark and light half in each 
well. The grid is IR light translucent, leaving the tracking of the 
zebrafish unaffected.

 High-speed camera. DanioVision is equipped with a camera 
capable of 1000 frames per second. The aim is to measure the 
startle response of larvae to a stimulus during a Pre-Pulse Inhibition 
test (Burgess and Granato 2007). 

 Split basin. The DanioVision basin has been modified so that it 
receives water at two different temperatures. The aim of this 
solution is to measure temperature preference in zebrafish larvae. 

 Ultraviolet Toplight Unit. This is a modification of the Toplight unit 
(see the previous page), which shines UV light. Light intensity is 
controlled by EthoVision XT.

 Turbo-cooling TCU. This is a modified Temperature Control Unit 
which keeps water at a constant temperature of 12° in a room 
where temperature is about 25°.

for more information

Manuals
For more information, see

 The EthoVision XT Help (press F1 in the EthoVision XT).

 The Reference Manual - Trial and Hardware Control in EthoVision 
XT. You can find this manual under Noldus > EthoVision XT 16 Other 
Documentation.
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 The Reference Manual - DanioVision Temperature Control Unit DV-
TCU. You can find this manual on the Noldus website 
(my.noldus.com). Note that you have to log in to access the 
downloads page.

You can also find other manuals on the EthoVision XT installation USB 
stick.

Sample experiments
EthoVision XT download page you can find sample experiments that 
make use of DanioVision. Browse to my.noldus.com, there under 
Downloads choose Sample projects, then EthoVision XT.

Experiment templates
EthoVision XT contains templates that help you setting up an 
experiment with arenas, analysis profiles and other elements already 
defined. See create a daniovision experiment on page 41.

References
See our web page of selected publications:

www.noldus.com/daniovision/resources

Support center
If after reading this manual you still have questions, please contact our 
Support center at my.noldus.com.
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2 What’s new in DanioVision

daniovision observation chamber

For users of DanioVision DVOC-0040
The white light LED array has been improved. The White light can be set 
to higher intensity.

For users of DanioVision DVOC-0030
 The housing has been completely redesigned. You open the 

observation chamber by tilting the lid along the top side. This way 
you have easier access to the camera and opening/closing the lid 
produces less vibration.

note  The DanioVision Observation Chamber is designed to block 
light from the outside. However, it cannot be guaranteed that it is 
completely dark inside the Chamber. For experiments that require 
absolute darkness (like experiments with day-night rhythms), place 
the DVOC in a dark room.

 The housing is now larger to create more space for accessing the 
video camera or adding devices. For this purpose, the housing can 
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be disassembled more easily than before. For the instructions see 
page 116.

 The basin has been redesigned. It has now a more flexible retainer 
that can hold a wider range of well plates. DanioVision can now 
work with ANSI, SBS compatible micro plates (L =127.76± 0.5 mm, 
W=85.48 ± 0.5 mm) with a maximum height of 27 mm, and with 
Petri dishes with a diameter up to 90 mm. To place small well 
plates and petri dishes, slide the bridge to a new position in such a 
way that the well plate/petri dish is in the middle of the camera 
view (left). For details see place well plates and petri dishes on 
page 37.

 The mechanism for moving the Fresnel lens located above the well 
plate has been improved. You can now move the lens all the way 
out of the camera view when you need to place containers higher 
than 27 mm. 

 Communication between DanioVision and EthoVision XT has 
improved via a new version of the hardware interface software. See 
install ethovision xt on page 22. 

 All four TTL lines TTL 1 to TTL 4 are available for communication with 
external devices. For connecting custom hardware, additional 
expansion connectors Expansion 1 and 2 are available. See Figure 3 
on page 15.

Figure 2  Positioning a well plate (left) and a petri dish (right). 
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 The White Light is now dimmable at very low intensity, without the 
need to operate the Low light switch located behind the camera. 

 The DanioVision Tapping Device has been designed to provide 
DanioVision with a reliable device which evokes a startle response 
in zebrafish larvae. See The DanioVision Tapping Device on page 72.

note  The DanioVision Tapping Device is a separate add-on to the 
DanioVision system.

For users of DanioVision DVOC-002x
 The DanioVision camera is now a Gigabit Ethernet (GigE) digital 

camera connected to the EthoVision XT computer through a 1-Gb 
Ethernet card. With a GigE camera, tracking can be done with a 
higher sample rate and higher resolution. 

 The intensity of the infrared LED back-lighting has been increased. 
This results in a more even distribution of back-lighting over the 
well-plate and a higher contrast between animals and the 
background. Therefore, it is easier to configure the detection 
settings and detection is better.

 It is possible to use very low light levels for the DanioVision White 
Light in addition to the default, standard White Light levels. The 
standard White light levels range from ±20 to ±10000 lux. The low 
White light levels range from 0 to ±20 lux.

 The anti-condensation mechanism can now be easily switched on 
and off, or set to automatic. The anti-condensation mechanism 
prevents the lens from condensing during an experiment.

ethovision xt
Here the main additions relevant to DanioVision are listed. 

For a complete list of the new features, see the EthoVision XT Help 
“What’s new” section.
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For users of EthoVision XT 15
 Improved Subject Contour filter. In the Detection Settings, a second 

Erosion filter is added to the Subject Contour settings. This filter is 
added after the pre-existing Erosion and Dilation, and improves 
detection in some difficult situations. For more information, see 
Advanced detection settings: Subject contour in the EthoVision XT 
Help.

 Trial Control variable in the analysis. In the Analysis profile you can 
now select the Trial Control variables used in the Trial Control 
protocols. This way you can analyze or visualize its values just like 
the other dependent variables. You can also visualize a Trial Control 
variable in the Integrated Visualization for testing purposes. For 
example, to check that a variable gets the expected value at a 
specific time in the trial.

 note  The Deep learning functionality in EthoVision XT 16 is not 
designed specifically to track fish larvae. In DanioVision 
experiments, always choose Contour-based as the body point 
detection technique.

For users of EthoVision XT 14
 Heatmaps are plotted together with a time scale. This helps you 

quantify the time that the subjects spend in specific locations.
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3 Set up DanioVision

connections
The back panel of the DanioVision Observation Chamber contains the 
following connections (see Figure 3 below):

1. Expansion 1. You can optionally use this connector to set up to 4 TTL 
out lines, to control external devices. For details, see page 127.

2. Temp. Connector for the temperature sensor. Use this in 
combination with the DanioVision Temperature Control Unit (TCU).

3. Cable grommet. If you install additional hardware inside the 
observation chamber, puncture the rubber membrane to let the 
cables pass through. For example, to connect the sensor of a digital 
thermometer placed in the water basin to a digital display outside 
the DanioVision Observation Chamber.

4. Gigabit Ethernet (GigE) camera connector. Use this output to 
connect the DanioVision camera to the EthoVision XT computer.

Figure 3  The back panel of the DanioVision Observation Chamber. See text for 
explanation. The label with the CE marking contains the product version.
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5. Expansion 2. This is a RJ45 type, 8-pin feed through connection. You 
can use it to connect future internal add-on hardware to get external 
signals in the DanioVision Observation Chamber.

6. Connector for water flow (see page 18 for details).

7. TTL1 to TTL4. You can optionally use these TTL input/output 
connections to control external devices such as a sound or shock 
generator, or the DanioVision Temperature Control Unit.

8. USB port (type Standard-B) to connect the DanioVision Observation 
Chamber to the EthoVision XT computer.

9. Connection for the 24 V power supply.

10.Connectors for water flow (see page 18 for details).

connect daniovision
Make sure the DanioVision Observation Chamber is placed on a level 
surface!

Power
Connect the DanioVision Observation Chamber’s 24 V socket (9 in 
Figure 3) to the power supply using the power cable and adaptor.

Video
Use the Ethernet cable with the large round connector to connect the 
digital video output of the DanioVision Observation Chamber (4 in 
Figure 3) to the Ethernet port labeled DanioVision camera on the 
EthoVision XT computer. 

The DanioVision camera must be connected to a 1-Gb Ethernet card. 
See page 23 for how to install this card on your computer. If you have 
purchased a PC from Noldus together with DanioVision, this card is 
already installed. Contact Noldus if you need a new Ethernet card for 
the DanioVision camera.
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White Light, Tapping Device, and other hardware
Use the USB cable that comes with DanioVision to connect the USB 
port of the DanioVision Observation Chamber (8 in Figure 3) to a USB 
port on the EthoVision XT computer. Do this only if:

 You want to control the White Light or the Tapping Device in the 
DanioVision Observation Chamber during data acquisition in 
EthoVision XT.

 You have the DanioVision Temperature Control Unit and you want 
EthoVision XT to take action if the water temperature gets too low 
or too high.

 You want to control any custom hardware connected to the 
DanioVision Mini USB-IO box.

Figure 4  Basic connections between the EthoVision XT computer and the 
DanioVision Observation Chamber. For controlling other devices like the Toplight 
Unit and the Temperature Control Unit, see the corresponding sections.
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set up a water-flow system
If you require a temperature-controlled water flow underneath the 
well plate, the Noldus DVTCU Temperature Control Unit is the preferred 
method.

The back panel of the DanioVision Observation Chamber contains 
three connections for controlling the water flow (see Figure 6): a water 
inlet (marked in green), a water outlet (marked in yellow) and a water 
overflow (marked in red).

Figure 5  The DanioVision DVTCU Temperature Control Unit.

Figure 6  The back panel of the DanioVision Observation Chamber, with the 
numbers indicating the connections of the water-flow system: 
 1 - water inlet; 2 - water outlet; 3 - water overflow.
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Connect the DanioVision Observation Chamber to the DVTCU using the 
tubes that match the color of the connectors. Please see the Reference 
Manual - DanioVision Temperature Control Unit DV-TCU for the 
complete instructions.

Suggested temperature
For Danio larvae, the temperature of the water flowing through the 
system is usually 28 degrees Celsius. You can set a different 
temperature when needed.

Figure 7  Tube connections between the DanioVision Observation Chamber and 
the DanioVision Temperature Control Unit. Color dots represents colors on the 
tubes. Arrows indicate the water circulation. 
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light and switches

Main switch
The main switch is located on the front panel. After you switch on 
DanioVision, wait at least 15 minutes for it to ‘start up’ and to avoid 
condensation in the system.

 

Internal LED light
The DanioVision Observation Chamber is equipped with a LED light to 
illuminate the inside of the chamber while you set up your experiment.
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Operate the Light switch at the left of the camera to turn the light on 
and off.

Anti-Moisture switch
This switch is located at the right of the camera. Operate this switch to 
adjust the anti-condensation mechanism (page 35).

Low light switch
This switch is located on the Mini USB-IO box, behind the camera at the 
back of the observation chamber.

 When the switch is set to H (default), the standard light levels are 
activated, from ±20 to ±10000 lux.

 Set this switch to L to allow very low light intensities, from 0 to ±20 
lux. For details, see page 36.
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install ethovision xt
 If you have purchased the DanioVision Observation Chamber 

including a computer from Noldus Information Technology, all 
software has been installed and tested. You can skip this section.

See Set up EthoVision XT on page 41

 If you use your own computer (or a computer you bought from 
Noldus IT in the past; in that case, make sure it meets the 
EthoVision XT system requirements), see below.

EthoVision XT 16 is supported with Windows 10 Pro, 64 bit. For more 
information about system requirements, press F1 in EthoVision XT.

Mini USB-IO box drivers
The Mini USB-IO box is the embedded electronics unit that 
communicates with EthoVision XT. The Mini USB-IO box makes it 
possible for EthoVision XT to control for example the white light 
stimulus. 

Before installing EthoVision XT, remove older versions of the drivers for 
the Mini USB-IO box. To do so:

1. In the Windows Control Panel select Programs and features.

2. Click each of the items whose name begins with Noldus_Hardware 
Interface.. and click Uninstall.

3. Insert the EthoVision XT Installation USB stick into your computer 
and follow the instructions to install EthoVision XT.

When you install EthoVision XT, the drivers of the Noldus Mini USB-IO 
Box are automatically installed.

important  When you open an experiment from EthoVision XT 12 or 
lower, a warning appears, informing you that you cannot open 
upgraded experiments in the old version of the software anymore. 
Make a backup of your DanioVision experiment in the older version of 
EthoVision XT before opening it in EthoVision XT. To make a backup, 
choose File > Make Backup. 

important  If you uninstalled the older version of EthoVision XT, you 
cannot use the Backup function. Instead, make a copy of your 
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experiment using Windows Explorer before you open it in the newer 
EthoVision XT version. Always copy the complete experiment folder 
and not only the *.evxt file otherwise your experiment does not open.

For more information
See Installation in the EthoVision XT Help for instructions on how to 
install EthoVision XT.

For more information on the Mini USB-IO box, see the Reference 
Manual - Trial and Hardware Control in EthoVision XT, which you can 
find on your EthoVision XT computer, under Noldus > EthoVision XT 16 
Other Documentation.

install the network card for the 
daniovision camera
DanioVision works with a Basler Gigabit Ethernet (GigE) video camera, 
connected via an Intel PRO/1000 CT 1-Gb Ethernet card installed on 
your computer.

If you ordered a computer from Noldus Information Technology when 
you purchased DanioVision, it came with that Ethernet card. The card 
has already been installed and tested. In that case, skip the sections 
below and continue with Chapter 4 on page 32. If you bought your 
computer somewhere else, you will have to install the Ethernet card 
yourself. This involves a few steps (see below).

Figure 8  The Intel PRO/1000 CT Ethernet card. 
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Step 1. Insert the Ethernet card in the DanioVision computer
1. Turn off your computer and all connected peripherals, such as the 

monitor and printer. Make sure that the computer is unplugged.

2. Remove the PC's casing according to the instructions provided in the 
PC's user manual.

3. Select a free PCIe expansion slot, and remove the corresponding 
extension cover.

When possible, choose the slot that gives maximum performance. 
To estimate performance, take note of the slot version (2, 3, etc.) 
and compare it with the following values:
- PCIe v1.x: 250 MB/s
- PCIe v2.x: 500 MB/s
- PCIe v3.0: ~1 GB/s
- PCIe v4.0: ~2GB/s
- PCIe v5.0: ~ 4GB/s

Note that values are given per lane; they should not be multiplied 
by the number of lanes in a slot (e.g. x4) since the card has a 1x 
connector). For example, SLOT1-PCIe3x4 means version 3.0, with 
four lanes.

important  Do not insert the PCIe board in the blue or white slots.

4. Unpack the Ethernet card, place it into the slot, and press it carefully 
into position. If the card does not fit into place easily, remove it and 
repeat the operation.
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When touching the board, its electronic components can be 
damaged by static electricity. To avoid any such risk, make sure that 
you are grounded. You can ground yourself by putting on an 
earthing wristlet, and attaching its clip to the metal frame of the 
computer. If an earthing wristlet is not available, you can hold the 
metal frame with one hand while holding the Ethernet card in your 
other hand. Ensure also that your clothing does not touch any 
components while handling the card.

5. Fix the card to the chassis and re-fit the computer's cover.

For more information about installing the camera and the Ethernet 
board, see Camera Installation in the EthoVision XT Help.

Step 2. Install the camera drivers
1. Insert the EthoVision XT installation USB stick into your computer.

2. Double-click EthoVision XT Setup.exe. If you have already installed 
EthoVision XT, select Modify.

3. Under Drivers and tools, select Basler GigE camera driver.

4. Continue with installation. Under Profile, select Camera User, then 
click Next.

5. Under Interfaces, select GigE, then click Next.

6. Connect the DanioVision camera to the port of the Ethernet card 
using a network cable (see D in Figure 3 on page 15).

Step 3. Assign the IP address to the Ethernet card
tip  Watch the video tutorial Set Up the Camera. In EthoVision XT, 
choose Help > Video Tutorial.

1. In Windows (here version 10), search for Network Connections. 

2. Right-click the Local Area Connection and click Properties. If your 
computer has more than one Local Area Connection, choose Basler 
GigE Vision Adapter. Write down the number of this connection.
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3. Select Internet Protocol Version 4 (TCP/IPv4) and click Properties.

4. Select the options: Use the following IP address and Use the 
following DNS server addresses and fill in the details as shown in the 
next figure. 

Also select the checkbox Validate settings upon exit. When done, 
click OK and then Close. 
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Step 4. Set the IP address of the DanioVision camera
tip  Watch the video tutorial Set Up the Camera. In EthoVision XT, 
choose Help > Video Tutorial.

1. In Windows, search for IP Configurator and start this application.

2. Select the camera. 

3. Fill in the details in the IP Address and Subnet Mask fields under 
Static IP Address as shown in the figure below. 

4. Click Save and then Close. 

5. Follow the instructions below to configure the DanioVision camera.
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configure the daniovision camera

Camera settings
The DanioVision camera that you received is already configured 
according to your setup. Noldus created three main settings profiles, 
called User Sets, stored in the Pylon Viewer software which controls the 
camera: User Set 1, User Set 2 and User Set 3. Only one User Set can be 
active at a time.

For each video resolution, you must use different camera settings and 
in some cases a different camera lens. For example, the video 
resolution determines the maximum frame rate. The higher the 
required resolution (in number of pixels), the lower the maximum 
frame rate (in frames per second). The three User Sets are specific for a 
combination of video resolution and frame rate (Table 1).

Which User Set is currently selected?
Make sure that EthoVision XT is closed. Start the Basler Pylon Viewer 
software and in the Features panel (for details, see the procedure in the 
next pages), under Configuration Sets, look for the item Default 
Startup Set. This is the User Set that contains the current settings.

Always check that the settings in Pylon Viewer for a particular User Set 
correspond to those in the table!

Note
EthoVision XT reads the settings from the camera driver software. For a 
specific EthoVision XT experiment you can override the values of video 
resolution and frame rate values that are stored in the driver, not other 
settings; see page 45.

The maximum frame rates have been measured with a 96 well plate 
setup. Other values may be optimal in other setups.
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1 User Set 1 is the default User Set in most applications. User Set 2 is pre-
selected if you purchased a 12-mm lens. User Set 3 is pre-selected if you 
purchased a 8-m lens. 

2 For User Set 2, Binning mode must be Summing. For other User Sets 
either option has no effect with binning equal to 1.

Table 1  Overview of predefined User Sets in the camera driver software and 
associated video frame rate, video size and required camera lens.

Resolution and 
maximum frame rate

1280 x 960, 
30 fps

640 x 480,
60 fps

800 x 600,
60 fps

Camera lens 12 mm 12 mm 8 mm + 
0.5 mm 
spacer ring

Settings in Pylon Viewer

A User Set1 User Set 1 User Set 2 User Set 3

B Pixel Format Mono 8 Mono 8 Mono 8

C Analog Gain 1 0 1

D Center X and Center Y

E Horizontal binning, 
Vertical binning2

1, 1 2, 2 1, 1

F Exposure TIme (Abs)  
in microseconds 3 

4000 2000 4000

Settings in EthoVision XT

G Resolution 1280 x 960 640 x 480 800 x 600

H Frame rate (fps) 30 60 60

I Color space Y800 Y800 Y800
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3 For all User Sets: Enable Acquisition Frame Rate must be selected.

Adjust the camera settings in EthoVision XT
In EthoVision XT, choose Setup > Experiment Settings and click the 
camera button. Adjust the settings according to the table on the 
previous page.

For details, see Adjust camera Settings in EthoVision XT in the 
EthoVision XT Help.

Adjust the camera settings in Pylon Viewer
You can also adjust the camera settings directly in the camera software 
Pylon Viewer. Adjust the settings according to the configuration you 
want to use in Table 1. First, choose a video resolution and frame rate 
combination, then mount the recommended camera lens, and next 
make the appropriate settings in Pylon Viewer. Finally, adjust the 
appropriate settings in EthoVision XT.

For more information about Pylon Viewer, see the Configure the digital 
camera in the EthoVision XT Help.

 Pixel format (column B inTable 1). 

 Analog gain (column C in Table 1).

 Center X and Center Y options (column D in Table 1). 

 Horizontal and Vertical binning (column E in Table 1).

 Acquisition frame rate and Exposure time (column F in Table 1).

tip  To preview the camera image, click the Continuous Shot 
button on the toolbar. 

tip  You can increase the Analog gain to 2 if you need a brighter camera 
image. However, the image noise will also increase, which may 
influence tracking.

To save the settings, click the Stop button and open the 
Configuration Sets item. From the Configuration Set Selector 
list, select the User Set you want to save the settings to. Next to User 
Set Save, click Execute. Select the User Set you want to use at a daily 
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basis. From the Default Startup Set list, select the User Set of your 
choice.

Camera view
Check that the camera view is correct by placing a wellplate in the 
DanioVision Observation Chamber. 

Make sure that:

 The well plate is in the middle of the field of view, not rotated or 
skewed. If not, see page 125.

 The well plate is in focus. If not, operate the focus ring of the 
camera lens.

 Fixation screws of all rings on the lens are tightened.

 The aperture is chosen such that the image appears slightly 
overexposed. With water in the well plate, the image is fine.

When you create an EthoVision XT experiment, check that the video 
Resolution, Video frame rate and Color space are as in Table 1 (page 29) 
for the User Set you want to use. 

See the next chapter and also Fine camera adjustments on page 122.
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4 Check the DanioVision system

Before you start setting up EthoVision XT, you need to check the 
following:

Camera
 The camera lens should have the correct aperture and must be in 

focus.

See page 33 

 The camera is correctly configured.

See page 28 

Anti-condensation mechanism
 You need to do this depending on the temperature inside the 

DanioVision chamber and the desired water temperature around 
the well-plate.

See page 35

White Light stimulus
 You need to do this when you want to use very low intensities for 

the DanioVision White Light.

See page 36 

Well plates and Petri dishes
 The well plate or Petri dish must be inserted correctly.

See page 37 

 Always control evaporation in the basin and in the well plate, 
especially when you carry out long trials (> 1 day).

See page 40 
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check the camera lens
Although the camera and lens are set up before shipment, the settings 
of the lens can shift during transport. Before you start to work with the 
DanioVision system, please check that the lens is set up correctly by 
doing the following:

1. The lens you use depends on the video resolution and frame rate 
you want to use. See the table on page 29.

2. Insert a well plate (o petri dish) in the basin.

3. Create a new EthoVision XT experiment (see create a daniovision 
experiment on page 41) and open the Arena Settings to see the 
camera image.

When water is not present in the basin, the image of the well plate 
should look overexposed, like the following:

4. Check the focus (see Figure 9). If the camera image is not in focus, 
loosen the screw, adjust the focus and tighten the screw.

The camera should be focused on the animals. The distance 
between animals and camera does not change much between 
types of well-plate and water level in the wells, however it is always 
a good idea to check the image before an experiment and adjust 
the focus until it is optimized.
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5. Check the aperture (see Figure 9).

The aperture has been adjusted in such a way that when the basin 
is filled with water, the video image is optimal for tracking (see 
example of a good video image on page 126). However, in the 
Detection Settings (page 64) check that detection of the larvae is 
good. If necessary, adjust the aperture to get a better contrast 
between larvae and background.

6. Make sure the camera is correctly configured (see page 28).

Notes
The more the aperture is closed, the larger the depth of field, which 
means that an object is ‘sharp’ at different distances from the lens. This 
is especially relevant when you work with a zoom lens and zoom in to 
focus on a smaller region of a well plate. On the other hand, closing the 
aperture decreases the contrast between animals and the background. 
Adjust the aperture until the image is optimized.

Figure 9  The 12-mm standard camera lens (left) and the 8-mm camera lens 
(right). The 8-mm lens has a spacer ring (already installed if you purchased this 
lens from Noldus). See also Table 1 on page 29 for which camera settings apply 
to which lens.
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configure the anti-condensation mechanism

Anti-condensation switch
The DanioVision Observation Chamber is equipped with an anti-
condensation mechanism to prevent water droplets forming on the 
lens during an experiment. A temperature sensor inside the 
DanioVision Observation Chamber checks whether the anti-
condensation mechanism should be switched on or off when it is set to 
Auto mode. Besides the Auto mode, you can also permanently switch 
the anti-condensation mechanism On or Off. The switch to set the anti-
condensation mode is located behind the camera, at the right side.

Auto 

Default and recommended when the DanioVision TCU is not used. The 
anti-condensation mechanism is automatically switched on when the 
air temperature inside the chamber drops below 28 °C (82.4 °F) to 

Figure 10  Position of the anti-condensation switch (labeled: 
Anti-Moisture) inside the DanioVision Observation Chamber.
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prevent condensation on the lens. When the air temperature inside the 
chamber exceeds 28 °C, the anti-condensation mechanism is 
automatically turned off to prevent heating of the water in the wells.

The value of 28 °C is a default setting of the embedded controller. 

note  If you use the DanioVision TCU, follow the instructions on the 
Reference Manual - DanioVision Temperature Control Unit DV-TCU, and 
set the switch to either On or Off.

Off
The anti-condensation mechanism is permanently turned off. Use this 
mode when the air temperature inside the chamber is equal to or 
higher than the actual water temperature of the basin/well plate 
water (in most cases 28 °C). You can use this option in combination 
with the DanioVision TCU.

On
The anti-condensation mechanism is permanently turned on. Use this 
mode when the air temperature inside the chamber is lower than the 
water temperature in the wells. You can use this option in combination 
with the DanioVision TCU.

configure the daniovision white light
In the DanioVision Observation Chamber it is possible to use very low 
light levels for the DanioVision White Light in addition to the default, 
standard white light levels. The standard light levels range from ±20 lux 
to ±10000 lux. The low light levels range from 0 to ± 20 lux.

Both standard and low light can be controlled in the same way by 
EthoVision XT’s Trial and Hardware Control. 

1. Locate the switch, behind the camera, at the bottom-left of the 
black mini USB-IO Box.
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2. Set the intensity of the White light.
- Right position H, standard high light level.
- Left position L, low light level.

place well plates and petri dishes

Well plates (ANSI standard)
1. Put the back of the well plate against the bridge and place it on the 

basin floor.
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2. Tilt the front of the well plate down to the floor. This way the water 
in the basin pushes the air from underneath the well plate. Make 
sure the well plate is accommodated correctly between the metal 
springs at the front and at the right side.

tip  Drill a few holes on the sides of the well plate to allow air to 
escape when placing the well plate.

Well plates (non-ANSI standard)
For smaller or larger well plates, place the bridge in a different position. 
The default position (ANSI standard) corresponds to the second hole on 
the side walls of the basin, when counting from the inner side of the 
observation chamber.

1. Remove the screws as indicated in the picture.
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2. Slide the bridge by one or more positions. 

Check the video image in EthoVision XT, and make sure that the 
well plate is centered in the camera view. 

3. Fix the screws in the corresponding holes.

Petri dishes
1. Put the Petri dish against the 90º angle of the bridge.
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2. If necessary, remove the screws of the bridge (see above) and slide 
the bridge of a few positions until the dish is centered in the camera 
view.

With DanioVision you can use Petri dish of diameter up to 90 mm.

We recommend not to let water flow in the basin when using Petri 
dishes. Water may flow underneath the bottom of the dish, making it 
shift from its original position during a trial.

control evaporation
Wells on the sides of the well plate tend to show a higher rate of 
evaporation than wells in the center. Also, wells at the front have a 
higher evaporation rate than those at the back.

Our recommendations
In long experiments (> 24 h), evaporation may occur for both the wells 
in the plate and the basin. 

 Wells: Check the wells every 24 hours and if necessary, refill them.

 Basin: Refill the basin every 2-3 days using the Basin Refill tool. For 
details, see the Reference Manual - Temperature Control Unit DV-
TCU.

The environmental conditions (temperature, relative humidity and air 
flow) and experimental conditions (lens heater on/off, White light 
intensity) influence the rate of evaporation (and condensation) of 
water from the basin and well plate. If you plan to carry out long 
experiments, always test evaporation at your environmental and 
experimental conditions, and plan refills to make sure that water drop 
never reaches a critical value.

tip  You can use a special syringe to refill the basin without having to 
open the DanioVision Observation Chamber. Contact Noldus for more 
information.
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5 Set up EthoVision XT

prerequisites
Before you can start working with the DanioVision system, you need to 
connect the DanioVision Observation Chamber to the EthoVision XT 
computer (see page 15) and, optionally, set up the water-flow system 
(see page 18). After you have turned on the DanioVision Observation 
Chamber with the switch on the front panel, wait at least 15 minutes 
for the DanioVision chamber to ‘start up’.

Also make sure to remove the lens cap from the camera.

Assign treatments to wells
To prevent systematic errors as a result of potential variation in 
temperature, light intensity or other unknown variable across a well-
plate, it is recommended to either assign larvae from different 
treatments randomly to the wells or make sure that wells containing 
different treatments (that is, different solutions or different 
concentrations of the same solution) are evenly distributed across the 
well-plate (so, for example, one type of solution is not only put in the 
center wells).

create a daniovision experiment

Preferred method
With this method, All arenas are created automatically, but need to be 
manually adjusted, using the Arrange Arenas option. Unnecessary 
functionality like manual scoring is removed from the interface and 
detection settings are optimized for DanioVision. 

If you select a template which contains more arenas than needed, you 
can exclude the unused arenas with Data selection (see page 106).

After you have followed the steps below to create the new experiment, 
you must still check/adjust Experiment Settings, Arena Settings and 
Detection Settings before you can track any animal correctly.
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1. Do one of the following:
- In the EthoVision XT Startup window, under New experiment, 

click New from template.
- Choose File > New from Template.

2. In the Select a template option window, click Apply a pre-defined 
template. Next, follow the instructions in the guided setup as 
described below.

3. Which video source will you use?

Select the option Live tracking (and saving video files), click the 
Sources button and select the Basler camera. Click Next >.

4. Which subjects will you track?

Select Fish and then Zebrafish larvae from the list. Click Next >.

5. How is the arena configured?

Select an Arena template from the list, then click Next >.
- DanioVision DVOC 004x, 24 round wells.
- DanioVision DVOC 004x, 48 round wells.
- DanioVision DVOC 004x, 48 square wells.
- DanioVision DVOC 004x, 96 round wells.
- DanioVision DVOC 004x, 96 round wells.
- DanioVision DVOC 004x/T, 24 round wells. *
- DanioVision DVOC 004x/T, 48 round wells.
- DanioVision DVOC 004x/T, 48 square wells.
- DanioVision DVOC 004x/T, 96 round wells.
- DanioVision DVOC 004x/T, 96 round wells.

*) Select one of the options with /T when you have installed the 
DanioVision Tapping Device and you want to use it in this 
experiment. For details see page 72.
tip  To know which DVOC version you have, 
see the serial number on the label located 
on the back panel.

- Open field, round.
- Open field, square.
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- Well plate, round wells - Select this option if you have a different 
number of round wells.

- Well plate, square wells - Select this option if you have a 
different number of square wells.

note  Arena templates are also present for older DanioVision DVOC 
versions: DanioVision DVOC 001x -003x.

note  If you selected a template for an older DanioVision version, it 
is possible that the DanioVision detection settings method does 
not give optimal detection of the larvae with images from your 
camera. If that is the case, use another detection method in the 
Advanced section of the Detection Settings pane. Consult the 
DanioVision manual that came with your setup, or see Configure 
Detection Settings in the EthoVision XT Help.

6. Initialize template experiment. Check here that all settings are 
correct and, if so, click Finish.

7. Enter the name of the experiment and click OK.

The EthoVision XT Overview window opens.

8. Follow all the next steps:
- Experiment Settings. See page 45.
- Arena Settings. See page 49. 
- Trial Control Settings. See page 57.
- Detection Settings. See page 64.

Other ways to create a DanioVision experiment
No matter which method you choose, when you create a DanioVision 
experiment unnecessary functionality like the Manual Scoring Settings 
is removed from the interface and detection settings are optimized for 
DanioVision.

 File > New from Template > Apply a custom template. Choose this 
method to create an experiment based on an existing one. For 
example when you want to replicate an experiment with the same 
number of arenas, the same trial control procedures, etc. For details, 
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see Create a new experiment based on an existing experiment in 
the EthoVision XT Help.

 File > New and in the window that appears select the option 
DanioVision experiment.

In the Experiment Settings, next to Number of Arenas enter the 
number of wells. With this option you have to draw the arenas 
manually. For more information on creating an experiment 
manually, see Set Up an Experiment in the EthoVision XT Help. 
Instead, we advise to create an experiment with a predefined 
template (first method), because all arenas are then defined 
automatically.
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experiment settings
Choose Setup > Experiment Settings.

Video Source
1. Under Video source, click the Video icon on the right 

side of the row of your camera. 

2. In the Video Settings window that appears, click the Formats tab 
and select the Resolution and Frame rate. Default resolution is 1280 
x 960 at 30 frames/s.

If you create an experiment based on a template with the Tapping 
Device, set the frame rate to 60 fps and reduce the resolution 
according to your setup (see the table on page 29). 
See also the guidelines in columns G, H and I in Table 1 on page 29.

From the Color space list, choose Y800. This is the color space for a 
monochrome video image. The other options, suitable for color 
images, do not apply to DanioVision.
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Tracked Features
Specify whether you want to track the center point of the fish (default) 
or the center point, the nose point and the tail base. Choose the latter 
option only if you track fish in a close-up image. 

Body Point Detection Technique
The Contour-based technique is selected. The option Deep learning is 
not available for fish tracking.

Analysis Options
If you are interested in how long and how frequent your subjects have 
been active vs. inactive, under Analysis Options select Activity analysis. 
Make sure you also adjust the Activity settings in the Detection 
Settings (see page 66).

For more information about setting up an experiment, see Set Up an 
Experiment in the EthoVision XT Help.

use of trial control hardware
Follow this section if you use stimulus devices like the white/color 
lights and the tapping stimulus device.

1. In the Experiment Settings, under Trial Control Hardware, make 
sure that Use of Trial Control hardware is selected and click the 
Settings button.

2. In the Hardware Interface window that opens, choose the type of 
system you have.

If you have DanioVision DVOC-0041:
- Choose DanioVision DVOC-004x/T if you use the Tapping Device 

in this experiment.
- In all other cases choose DanioVision DVOC-004x. 
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The other options DanioVision DVOC-001x - 003x are meant for 
older versions of the DanioVision Observation Chamber.

note  The option Mini USB-IO Box only applies when you use a Mini 
USB-IO box instead of DanioVision DVOC.

3. In the Device Configuration window, under Device features, the 
hardware devices activated for this experiment are listed.

4. optional  The default status of the DanioVision White Light 
Stimulus if Light off. This means that, when you start a trial, the 
white light is switched off. To use the white light as a stimulus, 
program its activation with Trial Control. If, however, you want to 
use the white light as a default lighting condition, and use the 
darkness as a stimulus, do the following:

a Click the White Light Default button. 
b Under Default device state, select Light on.
c Choose a percentage of intensity (0-100) and click OK.
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Then in the Trial Control procedure you can program when to 
switch the light off. See Trial Control Settings on page 57.

5. optional  If you connect additional hardware, under Plug-in devices, 
select the devices in the corresponding rows for TTL Port 1-4, or 
Expansion 1 / Port 1-4 depending on which port on the DanioVision 
back panel you use.

6. Click OK.

7. optional  If you set the default state of the White Light Stimulus to 
Light on, open the Trial Control Settings. This will confirm your 
selection.

Notes
 The Tapping Stimulus is listed under Device features when you 

select DanioVision DVOC-004x/T in step 2.

 If you upgraded from an older version of EthoVision XT, and you use 
an experiment created in the older version as a template for a new 
one, the DanioVision detection method is not available. Therefore, 
we recommend to create a new experiment with the newest 
version, and use this as a template (File > New From Template > Use 
a custom template).

 If you upgraded an experiment from an older EthoVision XT version, 
do not change the Trial Control Hardware Settings in the 
Experiment Settings. Leave Noldus Mini USB-IO Box selected in the 
Hardware Interface window. Otherwise the Trial Control rules, for 
example to control the white light, may not work. 

 When you change the default state of the White Light Stimulus to 
Light on, note that the white light is only switched on in one of the 
following cases:
- When you open the Trial Control screen.
- When you open the Arena - Hardware Mapping window.
- When you start a trial.

 For more information on Trial and Hardware Control, see the 
Reference Manual - Trial and Hardware Control in EthoVision XT. 
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6 Arena Settings

define the arenas
Choose Setup > Arena Settings > Arena Settings 1.

To define the arenas automatically
Follow these instructions if your experiment was created for well 
plates with 6, 12, 24, 48 or 96 round wells, or 96 square wells, and this is 
the first new Arena Settings in your experiment. In other cases, go to To 
define the arenas manually on page 52.

tip  Use well plates with no notches between wells. These result in 
better well detection. Also make sure that the borders of all wells are 
within the camera image.

1. In the Grab Background Image window, click the Grab button to 
grab a background image of an empty well-plate from the camera 
image.

2. If EthoVision XT can detect the wells, the outline of the arenas are 
displayed over the background image. A message appears asking 
whether the arenas overlap with the wells in the image.
6 - Arena Settings 49



3. Do one of the following:
- If there is good overlap like in the picture below, click Yes. 

If needed, you can always make small adjustments using the 
Arrange Arenas function (see page 53).

- If the arenas clearly do not overlap with the wells, or arenas 
overlap with each other, click No. The Arrange Arenas window 
appears automatically. See arrange the arenas on page 53 for 
details.

4. Click the 1. Draw Scale to Calibrate button.

Draw a line over the entire well-plate. Next, enter its size. Do this 
horizontally as well as vertically.

5. Click Validate Setup to validate the Arena Settings. Common errors 
are overlapping arenas, or zones falling outside an arena. If the 
setup is valid, continue with the instructions below. 
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Notes
 Arenas are marked with labels A1, A2, ..., B1, B2, ... according to your 

well plate (letters indicate rows; numbers indicate columns)

 Automatic detection of the wells in the video image has been 
tested with the DVOC-0040 and DVOC-0041. Success of automatic 
detection much depends on image contrast, focus, and distortion, 
and therefore we cannot guarantee it will work in all situations and 
with video made with previous DanioVision versions. Automatic 
detection also does not work if water is not present in the well 
plate.

 If automatic detection of the wells does not work, it could be due to 
the well plate being not centered in the video image.

See Fine camera adjustments on page 122.

 When the well plate image is optimal and centered, and still 
EthoVision XT shows the message Well plate detection failed, click 
OK and proceed with To define the arenas manually on page 52.

 To start automatic well plate detection, click the Well plate 
detection button  at the bottom of the Arenas and Zones 
section of the Arena Settings pane.
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To define the arenas manually
The following instructions apply when the automatic well plate 
detection does not work properly. In that case you must define one 
arena and then make duplicates.

If you used a predefined template to set up your experiments, go to 
arrange the arenas on page 53.

1. Click the 1. Draw Scale to Calibrate button, draw a line over the 
entire well-plate and enter its size. Do this horizontally as well as 
vertically.

2. If the current arenas are of shape different from that of the wells, 
select all arenas and press Delete.

3. Click 2. Select Shape and Draw Arena and use one of the shapes to 
create the first, top-left, arena. Make sure the label of the first arena 
(for example A1) points to the inside of the drawn arena. 

4. Click the outline of the arena or its label and then click the 4. Copy 
Arena button.

In the window that appears select All other arenas. Select the 
number of rows and click OK.

5.  Make sure the predefined arenas cover the wells. If you need to 
adjust the arena size and position, see arrange the arenas on page 
53. 
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arrange the arenas
1. in the Arena Settings window, click the 5. Arrange Arenas button. 

In the Arrange Arenas window, do the following:

2. To move all arenas: Under 1. Move Grid

To move up/down: Click the first slider. Move it the right (to move 
the arenas down) or left (to the arenas move up).

To move to the right/left: Click the second slider. Move it the right 
(to move arenas to the right) or left (to move them to the left).

You can also click the up/down arrow buttons of the corresponding 
box or enter a number in the box.

3. To scale all arenas: Under 2. Scale Arenas

Resize all shapes by using the sliders, by pressing the up/down 
arrows of the corresponding box or by entering a number in a box.

To increase the height of all arenas, use the first slider. To increase 
the width of all arenas, use the second slider

By default the option Keep proportions is not selected. Then you 
can resize the height and width of all shapes separately. If you 
6 - Arena Settings 53



select Keep proportions, you can change either the height, or the 
width while keeping the aspect ratio. 

4. To rotate all arenas: Under 3. Rotate Grid

Optionally, rotate all shapes. This is only necessary if the well-plate 
is not positioned straight. The shapes rotate around the center of 
gravity of Arena 1.

5. To change the space between arenas: Under 4. Arena Spacing

Change the space between the shapes.

By default, the option Keep proportions is not selected. Then you 
can change the space between the shapes separately in the vertical 
and horizontal direction (relative to the first row and first column, 
respectively). If you select Keep proportions, change the spacing in 
either the horizontal or vertical direction while keeping the aspect 
ratio. 

tip  First position the upper left arena in the desired position and 
make desired size (use scale). Next adjust arena spacing so all 
arenas are correctly positioned. See Using the Multiple Arena Setup 
in the EthoVision XT Help for information on setting up multiple 
arenas.
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6. Click Validate Setup to validate the Arena Settings. Common errors 
are overlapping arenas, or zones falling outside an arena. If the 
setup is valid, continue with the instructions below. 

To edit a single arena
Click the row in the Arena Settings pane for that arena.

The corresponding arena is highlighted.

For details on editing shapes, in the EthoVision XT Help see Arena 
Settings > Work with shapes.

assign the stimuli to the arenas
Follow this procedure if you want to apply stimuli during a trial, for 
example a light pulse or a tapping stimulus.

important If you created an experiment with a pre-defined template 
and selected the correct DanioVision arena template, the White Light, 
or Tapping Stimulus has been assigned automatically to the arenas. 
The steps below are then not necessary. 
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1. At the bottom of the Arena Settings pane, click the Arena - 
Hardware Mapping button.

2. In the Arena - Hardware Mapping window, do one or both 
depending on what you want to use:

a Click Add device. Under Arena 1, select White Light Stimulus.
a Click Add device. Under Arena 1, select Tapping Stimulus.

The devices White Light Stimulus and Tapping Stimulus only need 
to be assigned to Arena 1. They are in fact applied to all arenas.

3. Click OK.

For more information
  See also Test the hardware devices in the Reference Manual - Trial 

and Hardware Control in EthoVision XT.

 To set up the Tapping Device, see also The DanioVision Tapping 
Device on page 72.
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7 Trial Control Settings

Choose Setup > Trial Control Settings > Default or White Light Routine.

The template experiment contains two examples of trial control 
settings:

 Default - The default Trial Control Start-Stop rule. Use these 
settings to start and stop tracking manually.

 White Light routine. Use these settings when you want to provide a 
light stimulus during the trial. Ten minutes after the start of the 
trial, the DanioVision white light immediately turns on to 100% 
intensity for 10 minutes, then the white light immediately turns off 
for 10 minutes. This sequence of actions is repeated twice, using a 
sub-rule, after which the trial stops.
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 For using the White Light, see below.

 For using the Tapping Device, see page 72.

Maximum trial duration (recommended)
 If you record video: 60 minutes.

 Without recording video: 72 hours.

Set the duration of your trials in the Maximum Trial Duration pane or in 
the Start-Stop trial rule, by placing a Time condition immediately 
before the Stop track action box.

create your own trial control procedure
You can adjust these trial control settings to your own needs. The 
procedure below describes how to define Trial Control Settings from 
scratch.

For more information on Trial Control Settings:

 Trial Control in the EthoVision XT Help.

 The Reference Manual - Trial and Hardware Control in EthoVision 
XT, which you can find under Noldus > EthoVision XT 16 Other 
Documentation.

With the Trial Control Settings you can control the DanioVision White 
Light.
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Example: After a 24-hour dark period in the DanioVision Observation 
Chamber, you want to expose your animals to alternating periods with 
the white light on and off, in which the light-on periods also vary in 
intensity. This schedule is shown in the figure below.

To program this schedule:

1. To open the Trial Control, in the Experiment Explorer, right-click 
Trial Control Settings, select New, enter a name and click OK.

The Trial Control screen opens with the default Start-Stop trial 
control rule.

2. Click the Condition Time box with “Infinite time” and press Delete.

3. In the Components pane, under Actions - Hardware, click the button 
in the Add column next to White Light Stimulus. Select Create a new 
action.

4. In the Hardware Action window, set the following:
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- Action name. Enter a description of the action, for example 
“Light on 100%”.

- Action to perform. Select Light on from the list.
- Intensity level. Select the maximum intensity level of the light, 

in percentage (0 - 100%) or in Steps (0-4096). See some 
reference values on page 131.

- Fade duration. For example, with Intensity level of 50% and a 
Fade duration of 2 seconds, the white light gradually turns on 
until 50% of its maximum intensity in 2 seconds time.

5. Click OK and insert the Action box in the sequence.

6. In the Components pane, under Conditions, click the button next to 
Time. Click Create a new action and click OK. 

In the Time condition window, you can set the following:
- Condition name. For example, enter ‘Wait 15 mins’.
- Condition is met. For the option After a time of, enter ‘15 mins’.

7. Click OK and insert the Condition box in the sequence.

8. Repeat steps 3-6 to complete the Trial Control rule example 
described on page 59:
- Add an Hardware Action box with White Light - Off and a 

Condition Time box with “After 10 mins”.

Figure 11  This combination of Action and Condition box turns the White 
Light on at 100% intensity and keeps it on for 15 minutes.
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- Add an Hardware Action box with White Light - On 50% and a 
Condition Time box with “After 10 mins”.

- Add an Hardware Action box with White Light - Off and a 
Condition Time box with “After 10 mins”.

- Add an Hardware Action box with White Light - On 100% and a 
Condition Time box with “After 15 mins”.

tip  Combinations of Action and Condition boxes that are repeated 
in a sequence can be replaced with a sub-rule. This is especially 
handy when the entire sequence is repeated multiple times during 
a trial. For example: [White Light - On - 100%] > [After 10 min] > 
[White Light - Off] > [After 10 min]...

For more information on using sub-rules, see also the Reference 
Manual - Trial and Hardware Control in EthoVision XT.

9. Insert all the boxes in the correct order into the sequence and make 
sure you connect all boxes (see Figure 12 and Figure 13 on the next 
page for an example).

Figure 12  Example of Trial Control Settings. This is the first half of the Start-Stop 
Trial rule. In this example of Trial Control Settings, the repeated combination of 
Action box ‘Light off - 0’ and Condition box ‘Wait 10 mins’ to turn the White Light 
off for 10 minutes, has been replaced by a Sub-rule (see also the Figure on the 
previous page).
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Notes
 Click Test in the Hardware Action window to test the hardware 

action.

 Click Reset to reset all Hardware Action windows in your Trial 
Control procedure to their default values (for example a White Light 
action is set to off; however if you set the default White light to on 
(page 47), then after clicking Reset the White light switches on.

 To analyze data in the light or dark period, create first a Data profile 
that specifies that period using Trial Control State (see page 107). 
Then, calculate the statistics.

Use an external command
If you want to use an external command, for instance to play a sound 
during the trial, the command is executed for each arena. For example, 
the command to play the sound is repeated 96 times for a 96 arena 
experiment. To prevent this from happening, put a condition before the 
External command box, which will only become true for one of the 
arenas, for example Arena 1. In the Arena Settings, create a zone in 

Figure 13  Continued from Figure 12. This is the second half of the Start-Stop Trial 
rule. The Sub-rule is called a second time by the Reference box Light off (2).
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Arena 1 and call it “Zone 1A”. Make the zone as large as the arena. In the 
Trial Control Settings, make a condition like “Is subject in Zone A?”, 
followed by the external command. Make sure that the sequence does 
not interfere with the rest of the Trial Control rule, like in the following 
example.
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8 Detection Settings

What do you want to do?

 Track one subject per well/enclosure. See below.

 Track two or more subjects in the same enclosure. See page 67.

 Use Activity. See page 66.

one subject per enclosure
Choose Setup > Detection Settings > Detection Settings 1.

The template experiment contains a Detection Settings profile with 
DanioVision selected as method.
important  If you have upgraded EthoVision XT to version 15 while you 
have a DanioVision system older than the DVOC-0040, it is possible 
that the DanioVision detection settings method does not give optimal 
detection of the larvae with images from your camera. If that is the 
case, use another detection method in the Advanced section of the 
Detection Settings pane. For details, see the EthoVision XT Help.

1. Click the Auto-detect button.
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important Use the Auto-detect button every time you change a 
well-plate.

2. The Auto-detect window with a timer appears. Wait until it has 
disappeared. All larvae should now be detected well. If not, do one or 
more of the following:
- Open the Advanced section and move the Sensitivity slider. 

Moving the slider to the left results in detecting more of the 
body of the larvae, but also more noise. Moving the slider to the 
right results in detecting less noise, but also gives less good 
detection of the larvae.
If you see erratic tracks like that in the picture below (right), it 
means that small groups of pixels at the border of the well are 
sometimes detected as the larva. Move the Sensitivity slider to 
the right.

- If some larvae are not detected while they are in the corner or 
border of a well, check that the arenas are drawn well. Click the 
Show/Hide button on the toolbar and select Arena Features and 
then select the check box in front of Arenas.
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Check that the arenas cover the entire wells. In the picture 
below, the arena on the right does not cover the left margin of 
the well. Theref0re, the larva is not detected when swimming in 
that region.

- Try to maximize the contrast by opening the aperture of the 
camera lens (See “check the camera lens” on page 33.) However, 
make sure the light intensity is equal for all wells (that is, the 
center and outer wells).

- Certain compounds dissolved in the water can affect the 
pigmentation in the larvae, thereby decreasing the contrast of 
the animal and making detection of the animal more difficult. 
Make sure that EthoVision XT can still detect all animals after 
treatment.

3. If detection remains unsatisfactory, adjust the Advanced Detection 
Settings. The Dynamic subtraction method may give better results. 
For an explanation of the options, see Configure Detection Settings 
in the EthoVision XT Help.

activity analysis
Use Activity to quantify overall activity of your subjects. In the 
Experiment Settings (see page 46) select Activity analysis. In the 
Detection Settings pane, open the Activity section. Activity is shown by 
purple pixels in the video window. Set the Activity threshold in such a 
way that movements of the animals are detected and some noise is 
left.

For more information on activity, see Activity settings in the EthoVision 
XT Help. Also watch the video tutorial on Activity analysis.

For more general information on Detection Settings, see Configure 
Detection Settings in the EthoVision XT Help.
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multiple subjects in the same enclosure
Prerequisites: in the Experiment Settings, Number of Subjects is set to 
2 or higher.

1. Choose Setup > Detection Settings > Detection Settings 1.

2. Click Automated Setup and draw a rectangle around each subject.

3. Under Method, select Advanced Model / Adult Fish or Advanced 
Model / Other if the first does not give the expected results when 
tracking fish larvae.

note  The Advanced Model /Other method is not based on a 
modeled fish shape. With this method you cannot track the fish 
snout and tail. It is only available if the experiment is set to Center-
point detection only.
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9 Acquire data

There are three ways of acquiring data with your DanioVision system. 
For every option it is possible run single trials, but it is also possible to 
carry out batch acquisition. 

 acquire data live (page 69). The larvae are tracked as they move in 
their wells.

 acquire data live and record video simultaneously (page 70). 
The larvae are tracked as they move in their wells while at the same 
time a video is recorded. This gives you to opportunity to redo the 
tracking if necessary, either per trial or using batch acquisition.

 record video, then acquire data (page 71). You record a video first 
and then track the subjects offline from the video. Please note that 
if you only record video with EthoVision XT, Trial Control is not 
applied. So, for example, the white light is not switched on and off, 
if you only record video.

Before you start acquiring data, make sure you have carried out all the 
necessary checks of the system (see page 32).

Notes
 The DanioVision Observation Chamber is designed to block light 

from the outside. However, it cannot be guaranteed that it is 
completely dark inside the chamber. For experiments that require 
absolute darkness, place the DVOC in a dark room.

 important  In long experiments, evaporation may occur for both 
the wells in the plate and the basin. Check the wells every 24 hours 
and if necessary, refill them.

Refill the basin every 2-3 days using the Basin Refill tool. For details, 
see the Reference Manual - DanioVision Temperature Control Unit 
DV-TCU.

 Please read the section in the next pages that applies to your setup. 
For more information, see Acquire Data in the EthoVision XT Help.
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acquire data live
1. Make sure the camera is connected to the EthoVision XT computer 

and that Live tracking is selected as Video Source in the Experiment 
Settings.

2. Optionally, plan your trials in the Trial list and select the Arena 
settings, Detection settings and Trial control settings for each trial. 

3. Choose Acquisition > Open Acquisition.

4. If no trials are planned, click the New trial button in the Playback 
Control window or press Ctrl+F3.

5. In the Acquisition Settings pane, select whether you want to track 
only the next planned trial or whether you want to track all planned 
trials without having to start the next trial manually.

If you want to track all planned trials, specify the inter-trial interval. 
Enter a time long enough to be able to change well plates. When 
you change the well plate between trials, you can start the next 
trial without waiting that the inter-trial interval is reached. To do 
this, click the Skip remaining interval button in the Playback 
Control window.

 

6. Select whether you automatically want to start the analysis after 
the tracks are acquired. If that is the case, first define your 
dependent variables in an Analysis Profile (see Analyze data on page 
113). Optionally, first make a Track Smoothing profile and a Data 
profile to make a selection out of your data. 

7. Select whether you want to use the Track smoothing profile, Data 
profile, and Analysis profile that are highlighted in blue in the 
Experiment Explorer for analysis, or that you want to run analyses 
for all possible profile combinations. In the latter case, first delete all 
profiles you do not need for analysis. If you want to carry out 
analyses for only a selection of profiles, deselect the check box Auto-
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start analysis and carry out batch analysis after acquisition (see step 
5 on page 115).

8. Put the well-plate into the DanioVision chamber.

9. Click the Auto-detect button. A Re-initialize window with a timer 
appears. Wait until it disappears.

important  Use the Auto-detect button every time you change a 
well-plate.

10.To start the trial, click the Start trial button in the Playback Control 
window (or press Ctrl+F5).

11. To stop the trials, wait until Trial Control automatically stops the 
trials. To stop acquisition manually click the Stop trial button in the 
Playback Control window (or press Ctrl+F6). If you stop the trials 
manually, automatic analysis does not start. Also, for batch analysis, 
the next trials are not started if you stop a trial manually.

note  The recommended maximum trial duration when acquiring live 
without recording video is 72 hours (3 days).

acquire data live and record video 
simultaneously
To save video when doing tracking, follow the procedure above, with 
the difference that in step 4 you select the check box Save video in the 
Acquisition Settings pane.

If you realize tracking was not optimal, you can re-do tracking from the 
acquired video.

note  The recommended maximum trial duration when acquiring live 
and recording video simultaneously is 60 minutes. Longer trials 
produce video files of excessive size, more difficult to manage. 
Furthermore, if one large video gets corrupted then you lose more data.
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record video, then acquire data
If you use the option Save video only, track later, Trial Control is not 
applied so you cannot control the white light of the DanioVision 
Chamber with EthoVision XT.

To save video when doing tracking, follow the procedure on page 69, 
with the difference that in step 4 you select Save video only, track later 
in the Acquisition Settings pane. Also make sure that the trial is time 
limited, either with a time condition in the Trial Control start-stop rule, 
or with a Maximum Trial duration setting (page 58).

Next, you can acquire data using batch acquisition. Plan your trials in 
the Trial list and specify the video and optionally Arena Settings, Trial 
Control Settings and Detection Settings for each trial.

note  The recommended maximum trial duration when recording video 
is 60 minutes. Longer video recordings produce files of excessive size, 
more difficult to manage. Furthermore, if one large video gets 
corrupted then you lose more data.

drain and clean the system
At the end of the experiment, we recommend to remove all the water 
from the basin and the tubes.

If you use the Temperature Control Unit, DV-TCU, set it to Fill/Drain and 
follow the instructions in the manual Reference Manual - DanioVision 
Temperature Control Unit DV-TCU.pdf.

To prevent the growth of algae in the system:

 Always drain the system after use.

 Do not expose the system and the tubes to sunlight.
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10 The DanioVision Tapping Device

introduction
Larval stage zebrafish display a robust startle response, which is 
mediated by neural pathways similar to that in higher vertebrates. 
With the DanioVision Tapping Device you can evoke a startle response 
in zebrafish larvae.

How the Tapping Device works
The DanioVision Tapping Device is based on an electromagnetically 
inductive coil wound around a metal core. The core is made of two 
parts, a fixed one and a plunger connected to a push pin. When a 
current flows in the Tapping Device, magnetic force is created between 
the plunger and the core, causing the plunger and the push pin to 
quickly move forward (as indicated by the blue arrow in the picture). 
The pushpin hits a metal plate attached to the basin in which the well 
plate is kept. When deactivated, a spring makes the plunger resume its 
position. 
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How you control the Tapping Device
With the Trial and Hardware Control module of EthoVision XT you can 
plan when to activate the Tapping Device during a trial. For example, 
activate the Tapping Device 10 times at intervals of two minutes. 

Noldus test results: a summary
 In both light and dark conditions, the Tapping Device is capable of 

inducing a startle response in animals of 3 dpf and older. 

 It is in principle possible to design experiments where the animals 
are subject to stimuli of different intensity. You can set the tap 
intensity in EthoVision XT (page 76). 

 There is no evidence that the startle response measured by 
EthoVision XT depends on light conditions and location of the 
subject in the well plate.

See also the white paper Using the DanioVision Tapping Device, which 
you can download from our web site.

important  We advise you not to compare the results between two 
DanioVision Observation Chambers provided with the Tapping Device. 
Slight differences in the position of the Tapping Device may result in 
differences in the actual stimulus intensity, all else being equal!
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install the daniovision tapping device
If you order the Tapping Device together with a DanioVision 
Observation Chamber, the Tapping Device is already installed. In all 
other cases:

1. Open the lid of the DanioVision Observation chamber, and remove 
the bench plate (see also page 116).

2. Remove the two bolts from the aluminium plate at the bottom of 
the chamber as indicated in the figure below. Make sure that the 
backlight box does not move.

tip  Use a pencil to mark the exact position of the backlight box on 
the frame so that you can place it in that position if it accidentally 
moves.
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3. Put the metal frame of the Tapping Device over the aluminium 
profiles, and fix the bolts with the supplied spring washers. Use 
both the already connected spring washers and the new ones.

4. Connect cables as indicated here.

a The cable with a 4-pin white connector comes from the Tapping 
Device.

b The flat cable with a blue connector comes from the bottom of 
the DanioVision chamber. Raise the metal hooks, insert the 
connector, then lower the hooks to fix the connector.

c The cable with 2-pin connector comes from the bottom of the 
DanioVision chamber.
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5. Attach the control box to the aluminium profile at the front side of 
the observation chamber. 

a Insert the screw in one of the hole at the sides of the control box.
b Attach the spacers and the sliding nuts to the screw.
c Insert the sliding nuts into the profile, and turn the screw. 

6. Put the bench plate back into place and fix the four screws.

set up the tapping device in ethovision xt
Make sure that the DanioVision Observation Chamber is connected to 
your EthoVision XT computer.

Experiment Settings
Under Trial Control hardware, click Settings. In the Hardware Interface 
window, select DanioVision DVOC-004x/T.

Arena settings
note  If you created an experiment with a pre-defined template and 
selected an arena template for DanioVision with the Tapping device 
(DanioVision DVOC 004x/T), the Tapping Stimulus has been assigned 
automatically to the arenas. The steps below are then not necessary. 
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1. In the Arena Settings pane click Arena - Hardware Mapping and 
then click the Arena - Hardware Mapping button. 

2. Click Add device. Under Device type, select Tapping Stimulus. Under 
Arena 1 select Tapping Stimulus.

3. To test the Tapping Device, select the cell under Arena 1 and click 
Test.

Trial and Hardware Control Settings
1. Open the Trial Control Settings containing the protocol in which 

you want to insert the Tapping Stimulus. Under Actions - Hardware 
click the button next to Tapping Stimulus.

2. In the Hardware Action window specify the Intensity level (1-8). Click 
Test to get an impression of the tap intensity.

3. Click OK and insert the Action box in your Trial Control protocol. 

4. Test the protocol before carrying out the real trials.

important  Allow at least 300 milliseconds between two consecutive 
tapping events. To do so, place a Time condition box that specifies this 
time between two Tapping Stimulus Action boxes.
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analyze the response to the tapping stimulus
You can analyze the startle response by looking at dependent variables 
like Activity, Distance moved, or Acceleration (state) immediately before 
and after the administration of the stimulus.

In the following example, we examine the Total Distance moved in the 
1-second periods immediately before and after the tapping stimulus 
command was given. We expect that the total distance moved 
increased from “before” (assumed to be a baseline) to “after”. The 
stimulus command was given at exactly 1 minute after the start of the 
trial. 

1. In the Data profile define two Nesting time intervals, one from 
00:59.00 to 01:00.00, the other from 01:00.00 to 1:01.00. Each of 
the resulting Nest box is connected to a separate Results box.

2. In the Analysis profile define Distance moved.

The following picture shows the Distance moved plotted in Integrated 
Visualization.

Figure 14  An example of per-sample distance moved plotted against time for 
two subjects, and in the 1-s period before (59 s – 60 s) and after triggering the 
Tapping Device (60 s – 61 s). The hairline indicates the time that the stimulus was 
administered. 
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11 The DanioVision Toplight Unit

This manual explains the setup and operation of the DanioVision 
Toplight (type DVTL-0020) for the DanioVision Observation Chamber 
DVOC-0041.

note  The DanioVision Toplight Unit is an add-on to DanioVision; it 
does not come with a standard DanioVision system. For the 
specifications, see daniovision toplight unit on page 135.

connect the toplight unit

Components
 DanioVision Observation Chamber with built-in Toplight Unit.

 Desktop power supply, TTL-to-28V interface and cabling (see the 
figure below).

Operation
With this setup, two of the LED colors, or the white light can be 
switched on and off from EthoVision XT. The TTL-to-28V interfaces 
enable switching the power from the desktop power supply.

note  Whenever you would like to use all three colors (R-G-B) within 
one experiment you’ll need a second TTL-to-28V interface.

important  The LEDs get hot during operation. Please let the ceiling 
light cool down before touching it

important  Do not exceed the maximum specified voltage for each 
color as doing so may damage the LEDs

Setup for the white light
1. Desktop adjustable supply set to max 18 V for white light.

2. TTL cable to free TTL port on the DanioVision Observation 
Chamber’s (DVOC) back panel.
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3. White light cable plugged in.

4. Top light cable from the DVOC’s back panel.

5. Main LED power cable.

Connect the components
The LED power cable (coming from the back of the DVOC) has 4 
connectors, one for each LED color. The connectors belonging to the 
appropriate colors should be connected to the TTL-to-28V interface on 
outputs 1 and 2. 

The TTL network cable (green) should be connected between the TTL-
to-28V interface and port 1 on the DVOC (see the next figure). 

A main power cable connects the desktop power supply to the input of 
the TTL-28V interface. 
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1. USB cable to EthoVision XT computer.

2. TTL cable running to TTL-to-28V interface.

3. LED power cable.

operate the power supply
On the power supply the voltage can be set which determines the 
amount of light that the LEDs emit. The voltage may not exceed the 
maximum voltage for each LED color. This is 24V for the Red, Green and 
Blue LEDs and 18V for the white LEDs. 

important  Higher voltages may damage the LEDs. Before connecting 
to the mains outlet, check that the mains voltage matches the voltage 
setting of the power supply.

To power up, press the power button.
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To adjust the voltage
Turn the Voltage knobs for coarse and fine adjustments. Or when in 
presence of one knob, press once for coarse adjustments, and press 
once more for fine adjustment. The actual output voltage can be read 
from the display.

Both “Current” knobs can be used to set a current limiting value 
(maximum current). This feature is not needed; just set to the 
maximum level (turn full clockwise).

If not set properly, the supply may come in Constant Current mode (CC) 
and limit the output voltage.

It is good practice to first set your desired voltage before actually 
connect the main LED power cable to the supply.

For more information, see the supply manual.

change the lights

Two switch between red, green and blue
To change between colors, simply unplug the current connector of the 
LED power cable from the TTL-to-28V interface and plug in the correct 
one. Each connector is labeled.
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To switch between white and colors
If you want to switch from RGB to white light (or vice versa), turn the 
complete unit in order to have the right LEDs facing down towards the 
well plate.

The RGB LEDs and white LEDs are mounted on the opposite sides of the 
same plate and can be identified by the label white and rgb attached.

1. Cover the lens bracket with some protective material.

2. Untighten both left and right round black knobs to enable the unit 
sliding down a few centimeter, just below the camera. 

3. Pull the unit out and turn it upside down (facing the preferred LED’s 
down).

important  Be careful not to twist the cable at the back. Unplug 
temporarily both connectors to prevent this from happening.

4. Insert the unit and slide it up again.
11 - The DanioVision Toplight Unit 83



5. Tighten both round knobs.

configure ethovision xt to control the top 
lights
1. Start EthoVision XT and create a new experiment using a template 

(File > New from template). 

During the guided setup, choose Live Tracking, Zebrafish larvae, 
DanioVision [with the type of well plate you use].

2. Choose Setup > Experiment Settings. 

Under Trial Control Hardware, select Use of Trial Control Hardware 
and choose the options as in the figure below. Choose the TTL port 
of the DVOC that you connected (see above). You can rename 
Device ID to something like “Ceiling Light”.
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3. Choose Setup > Arena Settings. 

After calibrating and drawing the arenas, click Arena Hardware 
Mapping. Click Add device and follow the picture below. You can 
rename the text under Device name to something like “Ceiling 
Light”. Under A1 select the device. Then Click OK.
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4. To test the light, select Output 1 High or Output 2 High from the 
Command menu and click the Test button. To turn them off, select 
Output 1 Low or Output 2 Low.

program the top lights in ethovision xt
Choose Setup > Trial Control Settings.

Example: After 1 minute during the trial, switch the light on, then after 
10 seconds switch it off.

 Under Conditions, choose Time to create a time condition (e.g. Wait 
1 minute, Wait 10 seconds).

 Under Actions, choose Custom Hardware to define commands 
(Switch on/off). This can be done for both output 1 and output 2. 

Remember to connect all boxes with the start-stop procedure.
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Create routines
With the Subrule function you can create routines, to switch on and off 
the lights in repeated sequences. 

For more information, see the Reference Manual - Trial and Hardware 
Control in EthoVision XT. 

Also adjust the Detection Settings (Setup > Detection Settings) before 
running the trials.
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12 The DanioVision Optogenetics 
add-on

introduction
Optogenetics allow scientists to control the activity of specific neurons 
and study their downstream influence on a variety of biological 
processes, including behavior. In rodent studies, this technique requires 
optical fiber implantation. When working with zebrafish larvae, mostly 
transparent, fiber optics are not needed Light simply needs to shine in 
the right direction, making it easy to assess the effect of stimulation of 
specific, light-sensitive neurons on the behavior of the fish.

By inserting light-sensitive receptor proteins into neurons in vivo, it is 
possible to make those neurons sensitive to activation by light of 
specific wavelengths. In zebrafish studies, the light-sensitive receptor 
protein halorhodopsin (NpHR) has successfully been used to inhibit 
swimming behavior in zebrafish larvae (Arrenberg et al. 2009). Other 
research showed that channelrhodopsin-2 (ChR2) activation induced 
backward swimming in a sparse transgene expression line (Zhu et al. 
2009).

Optogenetics add-on
Application of optogenetic stimulation in zebrafish larvae requires the 
correct wavelength (i.e., color) of light. When using the DanioVision 
Observation Chamber, the Optogenetics Add-on provides a way to 
accurately control and precisely time the application of optogenetic 
stimulation to up to 96 individuals simultaneously (working with 96 
well plates).

The Optogenetics add-on for DanioVision is an optogenetic LED light 
source based on the Prizmatix Modular LED system. It consists of one, 
two or three LED wavelengths. The Optogenetics add-on can be 
programmed and controlled using the EthoVision XT software included 
with your DanioVision system. You can set user-defined time 
conditions for the optogenetic stimulation. In comparison to manual 
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control, this offers far better temporal precision and adds efficiency to 
longitudinal studies. 

References
 Arrenberg, A.B., Del Bene, F., Baier, H. 2009. Optical control of 

zebrafish behavior with halorhodopsin. PNAS 106: 17968-17973.

 Zhu, P., Narita, Y., Bundschuh, S.T., Fajardo, O., Scharer, Y.P., 
Chattopadhyaya, B., Bouldoires, E.A., Stepien, A.E., Desseroth, K., 
Arber, S., Sprengel, R., Rijli, F.M., Friedrich, R.W. 2009. Optogenetic 
dissection of neuronal circuits in zebrafish using viral gene transfer 
and the Tet system. Frontiers in Neural Circuits 3: 21.

Sample experiment
Your DanioVision system comes with an EthoVision XT sample 
experiment: DVOC_Optogenetics_Demo_Recommended.evxt. It 
contains examples of Trial Control rules for triggering pulse sequences 
in one up to three Pulsers.

Additional manuals
For connecting hardware

 Prizmatix UHP-T LED Illuminator User Manual.pdf

For programming the Pulser

 Prizmatix Pulser User Manual.pdf

For connecting the DanioVision Temperature Control Unit

 Reference Manual - DanioVision Temperature Control Unit DV-
TCU.pdf
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install the dichroic mirror in daniovision
When you receive the DanioVision Observation Chamber DVOC-004x 
with the Optogenetics add-on, the LEDs are already mounted so you 
only have to connect the cables (see the next section). However, the 
dichroic mirror comes in a separate box to prevent damage during 
shipping. This section explains how to install it. Please follow the 
instructions below. 

note  The function of the dichroic mirror is to direct the color light 
beams to the well plate, and at the same time allow light to reach the 
camera, so you can film and track the fish during the test.

1. Locate the box containing the mirror.

important Please wear the supplied gloves to avoid damaging or 
dirtying the mirror. Avoid touching the mirror surface and only hold 
its edges.

2. Locate the arrow on one side of the mirror. Once the mirror is 
mounted, this arrow should be at the top of the mirror and point 
towards the light source, that is, the backside of the Daniovision 
chamber.

3. Attach the mirror (see the next picture). Slide the mirror upwards 
along the brackets as indicated by the arrows.
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4. Position the mirror just above the mark on the right-hand bracket 
(see the picture below, 1). When the mirror is in that position, 
carefully tighten the screw on the left to fix the mirror (2). Do not 
apply any force as this may damage the mirror.

5. The mirror is now ready to use. See the next sections.
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important  The LED is extremely powerful and may cause eye injury 
when looking directly into the light source. For testing, we recommend 
to set the LED intensity to low.

the pulser software
Please skip this section if you do not use the Pulser/PulserPlus devices.

Follow the procedure below if you use one or more Pulser/PulserPlus 
devices. To control multiple devices, multiple instances of the Pulser 
software must be running on the EthoVision XT computer.

important  Do not connect the Pulser/PulserPlus device to the 
computer until the software setup process is complete.

Install the Pulser software once
1. Copy the installation files and folders to your computer’s hard 

drive.

2. Run the setup.exe file and follow the instructions as they appear on 
the screen. Next, restart the computer to complete the software 
installation.

3. Open the folder where the software has been installed (default: 
C:\Program Files (x86)\Prizmatix Pulser Plus 3.1) and make a 
shortcut to the EXE file. Give the shortcut a name that is easily 
recognized, like Pulser A or the name of the first LED.

4. To install or update the Pulser/PulserPlus drivers, see the Pulser/
PulserPlus User Manual.

Install multiple instances of the Pulser software
To control two or three LEDs independently using the dedicated Pulser/
PulserPlus devices, install one instance of the Pulser software for each 
Pulser/PulserPlus.

1. Install the first instance of the Pulser software (see above).

2. Browse to the folder C:\Program Files (x86) and copy the entire 
folder Prizmatix Pulser Plus 3.1.
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3. Paste the folder in the same location C:\Program Files (x86). 
Rename the folder to ... Prizmatix Pulser Plus 3.1 PulserB.

4. Open the new folder and make a shortcut for the EXE file that you 
find there. Place the shortcut on your desktop. Name it like Pulser B 
or the name of the second LED.

5. If you have a third LED, repeat the steps above from 2 to 4 to create a 
new folder which will contain a third instance of the Pulser software. 
Make a shortcut to the new EXE file and rename it to e.g. Pulser C. 

6. You should at this point have a folder structure like the following:

and three shortcuts on your desktop.

the led controller
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To control the LED manually:
1. Turn on the main power (see 1 in the figure above).

2. Set the switch near TTL (5) to Int.

3. Set the switch near Ain (6) to Int.

4. To turn the LED on, flip the switch (2) on.

To control the LED from EthoVision XT (through TTL)
1. Turn on the main power (see 1 in the figure above).

2. Set the switch near TTL (5) to Ext.

3. Set the switch near Ain (6) to Int.

4. To turn the LED on, flip the switch (2) on.

5. Connect the TTL cable with BNC connector from the pulser (or the 
USB-IO box, depending on the setup) to the connector TTL on the 
back panel of the LED controller (4).

6. In EthoVision XT you can now give the “high” command. See page 
100 or 101 depending on the setup.

Other controls
 Power adjustment dial (3).

 Analog input (Ain) connector (7).

 LED control cable connector (8).

 LED current cable connector (9).

 DC power jack (10).
94  12 - The DanioVision Optogenetics add-on



configuration 1 - without the pulser

Connection diagram
In the following example, EthoVision XT controls three LED controllers 
through the TTL ports in the DanioVision Observation Chamber. Note 
that each port contains two lines, with connectors white (Line 1) or red 
(Line 2). Each line controls one LED controller. 
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Define the pulse sequence
To define a pulse sequence, use actions and conditions in the 
EthoVision XT’s Trial Control Settings. For example a 1-s pulse of light in 
the first LED can be defined as: Action Light On on port 1 > Time 
Condition (1 second) > Action Light Off on port 1.

For information about creating pulse sequences in EthoVision XT, see 
the Chapter Optogenetics experiments in the Application Manual - 
EthoVision XT, which you can find on the EthoVision XT computer 
under Noldus > EthoVision XT Other Documentation.

USB ports
You need one USB port on the EthoVision XT computer, to control 
DanioVision.

TTL ports
 When using one LED, you can use the TTL-port 2 of DanioVision. Use 

the white connector at the other end of the cable to connect the 
LED controller.

 When using two or three LEDs, you can control two LEDs with one 
TTL port. Use TTL-port 2 for LED 1 and 2, and TTL-port 3 for LED 3. 
Remember that the white connector at the other end of the cable 
means Line 1, and the red connector means Line 2.
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configuration 2 - with pulsers

Connection diagram
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USB ports
On the EthoVision XT computer, you need:

 One USB port, to connect DanioVision (see page 17)

 Additional USB ports, one for each Pulser (see page 97). Connect the 
USB port of each Pulser to a USB port of your computer.

TTL ports
 When using one Pulser, you can use the TTL-port 2 of DanioVision. 

Use the white connector at the other end of the cable to connect 
the Pulser.

 When using two or three Pulsers, you can control two Pulsers with 
one TTL port. Use the DanioVision TTL-port 2 for Pulser A and B, and 
TTL-port 3 for Pulser C. Connect the other end of the cable to the 
Trigger In port of each Pulser. Remember that the white connector 
at the other end of the cable means Line 1, and the red connector 
means Line 2.

experiment settings
Choose Setup > Experiment Settings > Click Settings next to Use of Trial 
Control hardware. Then follow the section below that applies to 
choose the port numbers in the Device Configuration window.

tip  Open the sample experiment DVOC_Optogenetics_Demo_ 
Recommended.evxt. This is a live tracking experiment where basic 
settings in Experiment Settings and Trial Control are already selected 
for when you work with three pulsers.

Configuration 1 - without Pulser
Each LED controller is connected directly to one TTL port of 
DanioVision. If for example you have three LEDs, choose Port 2 for the 
first two LEDs, and Port 3 for the third one. See the corresponding 
scheme on page 95.
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Configuration 2 - with Pulser
Each Pulser is connected to one TTL port of DanioVision. If for example 
you have three Pulsers, choose Port 2 for the first two Pulsers, and Port 
3 for the third one. See the corresponding scheme on page 97. Under 
Device ID, give each port a name that can be easily recognized.

arena - hardware mapping
Choose Setup > Arena Settings. Draw the arenas (see this manual). 
When the arenas are ready, click the Arena - Hardware Mapping button 
and make sure that the devices are selected under Arena 1 (A1).
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The figure below refers to a configuration with three Pulsers.

trial control (no pulser)
important  Before you follow this section, make sure that (1) the 
dichroic mirror is installed in the DanioVision chamber (page 90), and 
(2) all components are connected (page 95) and powered up, and (3) 
that the LED controller is set to TTL control (page 93).

When the LED is controlled directly from EthoVision XT, activation 
occurs in Trial Control, using the Action boxes. The duration of the light 
pulse is determined by a Time condition placed between the Action 
Output 1 High and Output 1 Low.

In the example below, LED 1 (Device D in the Arena - Hardware mapping 
window; see above) is activated with a TTL signal Output 1 High and 
after 0.5 it is deactivated with a TTL signal Output 1 Low. The LED 
Controller must be connected to DanioVision through TTL Port 1 - Line 1 
(see page 95).

Use Output 2 High/Low commands to control the other LED controller 
connected to the same DanioVision TTL port.
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Make sure that the Int-Ext switch near TTL on the LED controller is set 
to Ext!

trial control (with pulsers)
important  Before you follow this section, make sure that (1) the 
dichroic mirror is installed in the DanioVision chamber (page 90), (2) all 
components are connected (page 97) and powered up, and (3) that the 
LED controller is set to TTL control (page 93).

Procedure
1. Open all the instances of the Pulser software by clicking on the 

desktop shortcuts Pulser A, Pulser B, and Pulser C. Each instance 
controls one pulser.

2. For each instance of the software, next to Select COM port, choose 
the correct COM port for the corresponding Pulser. These can be 
found on the pulser or on the connection diagram.

3. Next to Select Operation Mode, choose one of the following:
- When testing the Pulser, choose (0) Execute pulse sequence 

after START. By pressing the Start Sequence button, the LED 
flashes the configured sequence. 
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- When running the actual trials, choose (3) Execute pulse 
sequence after trigger HIGH, then stop when LOW. If you now 
click the Start Sequence button, the Pulser waits for a TTL trigger 
to start the sequence.

4. Enter the other settings in the dialog to control the pulse duration 
and the time between pulses. For details, see the Prizmatix Pulser/
PulserPlus User Manual.

5. Start EthoVision and open the example experiment: 
DVOC_Optogenetics_demo_recommended.evxt

In the Trial Control Settings you find predefined routines (called 
subrules) to control three Pulsers. The main procedure (top row) has 
been configured to consecutively trigger the three Pulsers using the 
corresponding subrules. Make sure the pulsers all have the correct 
COM port, are all in mode 3 and the start sequence button has been 
pressed. See also configure the com port for each pulser on page 
103.

Here below you find the basic actions to control the triggering of 
the Pulsers. For more information, see also the Chapter 
Optogenetics experiments in the Application Manual - EthoVision 
XT, which you can find in Start > Noldus > EthoVision XT Other 
Documentation.

Basic subrule
A basic set of instructions in a subrule activates the Pulser a number of 
times, as specified in the Subrule Reference box.

The boxes within the subrule specify an action to trigger the pulse 
sequence (Send a signal High to a device through line 1 or 2), a Time 
(wait a number of seconds) and a second action which stops the pulse 
sequence (Send signal Low to a device through line 1 or 2).
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In the following example, the subrule triggers the sequence in the 
Pulser A through Output Line 1, for 5 seconds. The name of the device 
selected next to Custom Hardware is 570 +520 nm, because it control 
two Pulsers, one for a LED of 570 nm (through Output Line 1) and one 
for a LED of 520 nm (through Output Line 2). You find the name 570 
+520 nm in the Arena - Hardware Mapping window of the Arena 
Settings in the demo experiment.

In practice, the subrule would look like the following:

Make sure that the Int-Ext switch near TTL on the LED controller is set 
to Ext!

configure the com port for each pulser

Aim
To configure the COM port in such a way the Pulser/PulserPlus accepts 
commands from EthoVision XT.
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Procedure
1. Connect the Pulser/PulserPlus to the PC using the USB cable with 

type-A to type-B connectors.

2. In the Control Panel, open the Device Manager.

3. Under Ports (COM & LPT), right-click USB Serial Port and select 
Properties.

4. Click the Port Settings tab.

5. Make sure that the parameters are as below, then click OK.
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6. Take note of the port number (in the example above it is COM3).

7. Repeat the procedure for each Pulser/PulserPlus.

Notes
 The COM port number is retained in the Pulser, so if you disconnect 

the Pulsers and reconnect them, you do not have to assign the COM 
ports again.

 tip  To know which COM port is assigned to which Pulser/PulserPlus 
device, disconnect the USB cable from one Pulser/Pulser Plus. Then, 
re-connect it. The item that appears under Ports (COM & LPT) 
indicates the COM port.

 tip  To change the COM port for a specific Pulser, in the Control 
Panel, open the Device Manager. Under Ports (COM & LPT), right-
click the COM port, select Properties, Port Settings, then Advanced. 
From the COM Port Number list select the COM port among those 
available.
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13 Data preparation

smooth the tracks

Track Smoothing profiles in the template experiment
 No Smoothing. Smoothing filters are not activated.

 MDM 0.2 mm - With this Minimal Distance Moved filter, you can 
reduce the effect of ‘jitter’ on the Distance moved variable. 
Applying this filter is recommended, however, it results in longer 
calculation times in the analysis.

Change these settings for your setup, if necessary.

More options
Use the Maximum Distance Moved filter to remove outliers in the 
track, due to erratic detection of objects within the arena. when the 
margin of the well is sometimes detected as the fish.

For more information on smoothing data, see Smooth the Tracks in the 
EthoVision XT Help.

select data

Data profiles in the template experiment
 All Data. With this Data profile you analyze all tracks separately.
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 Treated vs. Control - The data are split for analysis based on the two 
values of the user-defined variable Treatment: Treated and Control.

Analyze dark vs. light periods
In this example, the researcher wants to analyze the data in different 
light and dark periods, determined by the activation of the white light. 
In the Data profile, the function Trial Control State under Nesting is 
used to create intervals corresponding to the state of the white light. 

1. Choose Analysis > Data Profile > New. Give the new Data profile a 
name and click OK.

2. In the Components pane, under Nesting, click the button next to 
Trial Control State.

3. Select the period you are interested in, using the Trial Control 
actions. For example From Light On To Light Off (depending on what 
name the Light On/Off actions have in the Trial Control Settings).

4. Insert the Nest box in the Data profile sequence.

5. If you want to analyze different periods and have the results in the 
same table, create more Results boxes as shown in the picture 
below. To add a Result box, in the Components pane click the button 
next to Result. In each sequence, add a Nest box that specifies a 
different Trial Control State.
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6. Choose the dependent variables and run analysis (see page 113).

tip  See also the sample experiment DanioVision with 96 wells XT 
which you can download from our web site. There you can find the 
Data profile mentioned here.

Analyze data excluding periods of inactivity
In this example we want to exclude the interval in which a larva was 
not moving.

1. Choose Analysis > Data Profile > New. Give the new Data profile a a 
name and click OK.

2. In the Components pane, under Nesting, click the button next to 
Movement.

3. In the Movement tab, you can set the following:
- Averaging interval (range 1 - 1000) – This is the number of 

samples across which changes in speed are calculated to 
determine whether the subject is moving or not. In order to 
reduce the sensitivity of the Movement variable to brief changes 
in velocity, the velocity data can be smoothed by taking the 
running average of the last n samples. Enter the averaging 
interval n or leave 1 if you do not want to smooth the velocity 
data.

- Start velocity – The velocity above which the subject is 
considered to be moving.
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- Stop velocity – The velocity below which displacements of the 
subject’s body points are no longer attributed to locomotion but 
to system noise, body wobble or pivoting on the spot.

4. Under Calculate nesting for, select Not moving.

5. Click OK. Insert the Nest box in the appropriate position between 
the Start and the Result box.

6. Choose the dependent variables and run analysis (see page 113).

For more information on the Nesting functions, see Analyze Track 
Segments in the EthoVision XT Help.

Analyze the intervals around the onset of the white light
In this example, we want to analyze two intervals:

 From 5 seconds before the onset of the White light stimulus, to the 
onset of the stimulus.

 From the onset of the White light stimulus, to 5 seconds after the 
onset of the stimulus.

The aim is to compare activity, speed and other parameters between 
the two intervals.

1. Choose Analysis > Data Profile > New. Give the new Data profile a a 
name and click OK.

2. In the Components pane, under Nesting, click the button next to 
Free interval.

3. Do the following:

Under Start criterion, select Trial Control. Choose the options as in 
the picture below.
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Under Stop criterion, select Time. Next to Elapsed time leave 
0:00:00.000 after start event selected. 

note  “Start event” here refers to the White light selected under 
Interval start.

Click OK and insert the Nest box in the sequence.

4. To create the second interval, choose first Result under Common 
elements. Click the middle of the Start box and drag to the Result 2 
box; this will connect the two boxes.
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5. Repeat the steps 2-3 to create a new Nest box, this time for the 
interval “from White light to 5-s after that”. In the settings, choose 
the criteria for the second interval: from “Trial Control - 0 seconds 
before Action: Light on” to “Time - Elapsed time 5 seconds after start 
event”.

Click OK and insert the Nest box in the sequence.
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6. Choose the dependent variables and run analysis (see page 113).

tip  Click Settings in the Result boxes and rename them, to for example 
“5-s Before white light” and “5-s after white light”. Those names will be 
shown in your results.
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14 Analyze data

analysis profiles and options

Analysis Profiles in the template experiment
 Distance, Time & Movement - Contains the dependent variables 

Distance moved, Velocity and Movement.

 Path Shape - Contains the dependent variables Heading, Turn angle, 
Angular velocity and Meander.

 Rotation - Contains two instances of the dependent variable 
Rotation, to count the number of clockwise and counterclockwise 
rotations.

For more information on these and other dependent variables, see 
Dependent Variables in Detail in the EthoVision XT Help. Also see 
Analysis of Trial Control data in the Reference Manual - Trial and 
Hardware Control in EthoVision XT.

Analyze intervals
Make sure you have defined a Data profile which specifies the intervals 
you are interested in (see page 106). Next, in the Analysis profile choose 
your variables (e.g. Distance moved). Then visualize the data (see an 
example in Figure 15) and run analysis (see page 115).

Activity analysis
You can also use the dependent variable Activity state. This variable is 
only available when you selected Activity analysis in the Experiment 
Settings (see page 46 and page 66). 

With Activity state you can calculate how long and how frequent your 
subject has been in different activity states. These states depend on the 
total pixel change within the arena between a sample and the previous 
sample. It is important that all defined arenas have exactly the same 
size. The number of states (two to four) and their thresholds are user-
defined.
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Analyze convulsions
To analyze convulsions, you can use several variables, such as Velocity, 
Activity and Mobility. If you use Mobility, start with setting a High 
Mobility Threshold to a high value like 95%, and an averaging interval of 
2. Compare the scores of Highly Mobile with those of convulsions 
obtained manually.

Figure 15  Example of visualization of data after nesting over a Trial Control State. 
Here the samples of Arena 1 are displayed in full color when the white light was on. 
Only those samples are subject to analysis. The first plot is of the variable Trial 
Control State (defined as: From Light on to Light off; it illustrates the effect of 
nesting), and the second is of Distance moved defined in the Analysis profile.
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calculate the statistics
The instructions below describe the general procedure of selecting a 
dependent variable and calculating statistics for that variable.

1. Choose Analysis > Analysis Profile. In the Analysis Profiles window, 
select New and type a name for the new profile, then click OK.

2. Click the Add button next to the dependent variable you want to use 
for analysis (for an overview, see Dependent Variables in Detail in 
the EthoVision XT Help).

3. In the window that appears, select the properties of the dependent 
variable. 

In the Trial Statistics tab, choose the statistics you want to calculate 
per trial for that variable. If you run multiple trials, select additional 
statistics in the Group Statistics tab. 

4. Repeat steps 2-3 to add more dependent variables.

5. Choose Analysis > Results > Statistics & Charts. Choose the Data 
Profile from the list on the tool bar and click the Calculate button.

6. The results appears on the screen. The Trial Statistics tab shows the 
statistics per trial. The Group Statistics & Charts tab shows the 
statistics and charts from the summarized results of all trials. See 
Calculate Statistics in the EthoVision XT Help for how to read and 
customize your results.

7. optional  Click the Layout button to modify the layout of the results 
table. 

Batch calculations
It is also possible to carry out multiple analyses with different filters, 
data profiles and analysis profiles. To do so click the Batch button.

Make your selection from the lists under Select the profile 
combinations to calculate and click Add. When done, click Calculate. To 
view a specific analysis result, select the options from the lists on the 
toolbar. For more information on batch statistics calculation, see Batch 
statistics calculation in the EthoVision XT Help.
14 - Analyze data 115



A Open the DanioVision casing

tools you need
A Phillips or (preferably) a Pozidrive 
screwdriver, size 2.

Do not use electric screwdrivers!

bench plate
Remove the bench plate, for example, to 
install the Tapping Device and other, 
custom hardware you want to place 
inside the DanioVision Observation 
Chamber.

Also when opening the top casing (page 
117) it is handy to first remove the bench 
plate.

1. Remove the four screws as indicated in the picture below.

2. Remove the bench plate.
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top casing
Remove the top casing, for example, when 
you need to replace the camera.

1. optional  Remove the bench plate first (page 116), this makes the 
following steps easier.

2. Remove the eight screws as indicated in the picture below. 

Note that the screws located more internally are shorter than the 
others. These are attached to the aluminium frame.
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3. Close the lid and lift the top casing.

4. When putting the top casing back in place, make sure that you insert 
the sides into the bottom casing as indicated in the picture below. 
Then, tighten all the screws.
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sides and back casing
Remove the sides and back casing to 
access the connector box, wirings and 
internal tubings. In most cases you do 
not need to do so.

1. Follow the instructions on page 117 to remove the top casing.

2. Put the DanioVision Observation Chamber just over at the edge of 
the table and remove the three screws from the bottom plate. 
Repeat this step for the other side.
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3. Remove the two screws at the back as indicated in the picture below.

4. You can now lift the casing.
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connector panel
To remove the connector panel at the back of the observation chamber, 
remove the four screws as indicated in the picture below.

adjusting lid friction
You can adjust the friction of the Observation chamber lid. 

If the lid falls down easily or opens with much friction, it can be 
adjusted by loosening or tightening the three screws per hinge. 
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B Fine camera adjustments

Each DanioVision system is thoroughly checked and set to its optimal 
configuration. However, transport and handling of the system may 
sometimes cause slight changes in the camera position relative to the 
well plate, resulting in a sub-optimal video image. This section helps 
you restore the original settings. To open the DanioVision casing, see 
page 116.

centering the well plate horizontally
If the well plate is not centered horizontally:

1. Loosen the washer located behind the camera bracket, under the 
camera profile. 
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2. Turn the camera in the direction required until the well plate is in 
the middle of the camera view.

3. Tighten the washer to fix the camera in the new position.

centering the well plate vertically
If the camera is rotated forward or backward in its vertical plane, the 
video image may look like this:

1. Loosen the two bolts at the sides of the camera profile.
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2. Rotate the camera bracket forward or backward until the well plate 
is centered vertically in the video image.

3. Tighten the bolts.
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if the well plate looks rotated
If the margin of the well parallel is not parallel to the margin of the 
video image:

1. Open the DanioVision Observation Chamber and locate one of the 
bolts at the side of the camera profile (either left or right):

2. Loose the bolt using a 3-mm Allen key.

3. Gently move the camera bracket forward or backward until the well 
plate is in the correct orientation. When ready, tighten the bolt.
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example of a good video image
Check that the well plate fills the video image as much as possible, 
with the letters A-H and numbers 1-8 well visible. 

Set the camera lens to maximum aperture. The image is overexposed 
when no water is present. 

Below an example of a good video image when water is present:

Tighten the three screws on the camera lens once the image is 
optimized.
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C Additional hardware

DanioVision offers additional connectors to attach and control custom 
hardware. These are Expansion 1 and Expansion 2 located on the back 
panel.

expansion 1
Expansion 1 is a female 25-pin DB connector. It provides four additional 
TTL out lines to control external hardware and input/output lines to 
trigger the DanioVision camera (for example at a specific event). 
Numbers in black indicate pins currently available. 

Pin number Description

1 TTL-out port 1

2 TTL-out port 2

3 TTL-out port 3
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TTL-out ports are open collector outputs with a common emitter on pin 
9 and 10. Voltage range 0 to 5 V.

Specify the custom hardware in the corresponding row of the Device 
Configuration window. For details, see experiment settings.

For more technical details and how to use these connections, contact 
Noldus Information Technology.

4 TTL-out port 4

5 - 8 Not available

9 Common emitter for TTL-out ports

10 Common emitter for TTL-out ports

11 I/O output camera

12-21 Not available

22 GND I/O camera

23 I/O input camera

24-25 Not available
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expansion 2
Expansion 2 is a 8-pin modular RJ45 feed through 
connector. 

You can use it to connect internal add-on hardware and get external 
signals in the DanioVision Observation Chamber.
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D System specifications

daniovision dvoc-0041

Power supply
 Power requirements: 24 Volt DC, 2.0Amp (max)

 Mains adapter: input 100-240 Volt AC, output 24 Volt DC, 3.0Amp

Camera
 Brand, type: Basler acA1300-60gm

 Interface: Gigabit Ethernet (RJ45 connector, CAT5e or higher)

 Sensor: 1/1.8” Progressive Scan CMOS, monochrome

 Max. resolution: 1280 x 1024

 Max. frame rate: 60 fps

Lens
 12 mm Megapixel, C-mount, F1.4, includes IR pass filter

 Optional lens: 8 mm Megapixel, C-mount, F1.4, includes IR pass 
filter

Video performance (H x V pixels)
 Default: 1280 x 960 at 30 fps (in combination with 12 mm lens)

 Optional: 
- 640 x 480 at 60 fps (in combination with 12 mm lens)
- 800 x 600 at 60 fps (in combination with 8 mm lens)

Maximum frame rates as measured in 96 well plate setup.

Backlight unit
 Combined infrared (IR) and white light array

 Infrared wavelength (typical): 950 nm
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According to published research, zebrafish are sensitive to infrared 
light, though not above 910 nm. See Shcherbakov et al. 2013, PLoS 
ONE 8(5): e64429. The IR light provided by DanioVision is therefore 
unlikely to affect the fish’s behavior.

 White light color temperature (typical): 5500ºK

 White light level controllable via USB (EthoVision XT). Intensity 
range: 0 to ±10000 lux (light level measured directly at the bottom 
of the water basin).

With the standard White Light settings, the light intensities of the 
white light are approximately:

 
note  If you set the Low Light switch to L (low), the highest light 
level (100%) is around 20 lux. See configure the daniovision 
white light on page 36 for more information.

note Light intensity in DVOC-0041 can be set higher than in DVOC-
0040. Here the reference values if you have DVOC-0040:

You may want to replicate light conditions that you set in 
DanioVision DVOC-0040 in a new experiment with DanioVision 
DVOC-0041. For example, if you set light intensity to 50% in 

Percentage Steps Intensity (lux)
5 207 139
25 1000 2500
50 2100 5300
75 3000 8000
100 4095 10500

Percentage Steps Intensity (lux)
1% 40 70
25% 1025 1450
50% 2050 2950
75% 3000 4400
100% 4096 5450
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DanioVision DVOC-0040, this gave 2950 lux. The percentage to be 
set in DanioVision DVOC-0041 is (2950/5300)*50 = approx. 28%.

Multi basin
 Water inlet, water outlet and overflow 

 Basin size 158 x 132 mm

 Supports ANSI, SBS compatible micro plates (L =127.76± 0.5 mm  
(5 1/32” ± 1/64”), W=85.48 ± 0.5 mm (3 23/64” ± 1/64”) with 
maximum height of 27mm (1 1/16”)

 Supports Petri dishes up to 90 mm in diameter

 Temperature sensor supporting the use of Noldus DVTCU 
(Temperature Control Unit)

Water connections
 Water inlet/outlet: tube fitting 8 mm

 Water overflow: tube fitting 10 mm

Tubes included
 1.5 m Clear PVC Hose, 8 mm OD, 5 mm ID for water inlet (green color 

marked)

 1.5 m Clear PVC Hose, 8 mm OD, 5 mm ID for water outlet (yellow 
color marked)

 1.5 m Clear PVC Hose, 10 mm OD, 8 mm ID for water overflow (red 
color marked)

PC interface
 USB-2 compatible

External I/O
 TTL input/output (4x modular RJ45 connector):

- 4 x 2 TTL input
- 4 x 2 TTL output
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 TTL expansion port 1:
- 4 x TTL output (open collector output)
- 1 x input camera
- 1 x output camera

 TTL expansion port 2 (1x modular RJ45 connector:
- 8-pin feed through

System start-up time (cold start)
 ~ 15 minutes

Dimensions
 61 x 32 x 46 cm (24 1/64” x 12 19/32” x 18 7/64”) (h x w x d) in closed 

position

 Door opening 36 x 29 cm (14 11/64” x 11 27/64”) (h x w)

Weight
 15 kg excluding power supply, external tubes and cables

Cleaning the DanioVision Observation Chamber
We recommend to use a propriety glass-cleaning fluid to clean the 
outside of the DanioVision Observation Chamber.

Declaration of conformity
See page 136.
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daniovision tapping device

Power
 Power requirements: 24 Volt DC, 0.4Amp (max)

Features
 Controlled from EthoVision XT 10.1 or later with selectable stimulus 

intensity (1-8)

 Delivers a discrete ‘tap’ to the well plate holder

 Maximum tapping rate of ±3 taps per second

Connectors
 Molex 2 pin – Power (24V)

 Molex 4 pin – From Tapping Device to control box

 Multi connector (blue) – For TTL control signal

Dimensions
 Tapping Device (including aluminum bracket): 6 x 24 x 7.5 cm  

(2 23/64” x 9 29/64” x 2 61/64”) (h x w x d)

 Control box: 2.5 x 10 x 6.5 cm (63/64” x 3 15/16” x 2 9/16”) (h x w x d)

Weight
 ~ 300g (Tapping Device, bracket, control box) 

 If not pre-assembled in the DVOC-0041, the package includes 
mounting material

Compatible DanioVision Chambers
 DVOC-0040, DVOC-0041
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daniovision toplight unit

White light
> 30.000 lux at 25cm distance (well plate), 1584 lm

Color temperature 4000K

Array of 408 LED’s

Max. voltage 18 Volt

Red light
192 lm, wavelength 623 nm

Array of 252 RGB LED’s

Max. voltage 24 Volt

Green light
384 lm, wavelength 525 nm

Array of 252 RGB LED’s

Max. voltage 24 Volt

Blue light
240 lm, wavelength 470 nm

Array of 252 RGB LED’s

Max. voltage 24 Volt

Unit Dimensions

270 x 220 x 30mm   (10 5/8” x 8 21/32” x 1 3/16”)
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declaration of conformity
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